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The latest speedy evolution of technology has 

also impact on the modern land surveying 

techniques in a massive way and the fresh 

impression is yet to come day by day.  
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Survey Department of Sri Lanka who 
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Global Surveyors’ Day 

Dr.K.Thavalingam, Retired Surveyor General 

____________________________________________________________________________________ 

 

The Global Surveyors‟ Day aims to improve Surveying education and competence globally, upkeep the 

standards of professional surveyors and surveying technologists practiced around the world and 

dismantle the borders between surveying professionals in different places, thereby enhancing mobility 

of surveying professionals and ensuring a high standard of professional practice.  

 

21
st
 March has been recognized Global Surveyors‟ Day that will be celebrated in various countries of 

the world every year. The Day recognizes the work of surveying, mapping and geospatial professionals. 

This is a worldwide event initiated by the International Federation of Surveyors (FIG) based in 

Denmark, the Council of European Geodetic Surveyors (CLGE), and the National Society of 

Professional Surveyors (NSPS) in the USA. FIG has initiated celebrating this Day by country surveying 

associations around the world. 

 

Land surveying was used by man in early times- and is still being used. It shows how important land 

surveying is for our survival. Most people never know about land surveying until they needed it at some 

point. Many of us hear about land surveying all the time but never really give it much thought. It means 

surveyors are unobserved and invisible to the public. So, surveyors are by observing Global Surveyors 

Day, also in Sri Lanka as Surveyors‟ Day, making the invisible experts to visible experts. 

 

Many historians refer to Land Surveying as the second-oldest profession. The first examples in the 

history of land surveying date back to the ancient Egyptians during the building of the Great Pyramid at 

Giza in 2700 BC. There is evidence of the Egyptians using basic geometry to redraw boundary lines 

when the Nile overflowed its banks. Also, an Egyptian Land register existed as early as 3000 BC. 

Historical evidence shows that the Roman Empire was the first civilization to employ an official land 

surveyor within their Empire. 

 

In ancient Babylon, Kudurrus were stone tablets that served as boundary stones upon which details of 

the property, the surveyor, the owner and property history were all inscribed. These were used upto 

1200 BC.(See figue-1) 

 

 

Both the Romans and Greeks made use an early surveying 

instrument called the Groma, which was basically a long staff 

with a cross bar that measured straight lines and right angles.  

Chorobates and libella were used for levelling. The dioptra 

was a different kind of angle measuring instrument. It rested 

on the ground, and was finely adjusted by tilting and rotating 

the top part by means of precision screws, it could assess the 

angle of a stretch of aqueduct by looking through pivoting 

sights. 
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In England in 1086, William the Conqueror wrote the 

Domesday Book, which covered all of England and contained 

the names of the land owners, the amount of land they owned. 

(See figue-2) 

 

 

 

 

            ( Figue-2)  

 

Surveyors in Sri Lanka have contributed greatly to Sri Lanka‟s phenomenal development over the years 

using innovation, creativity, a wealth of knowledge and expertise. Sri Lanka as country which had 

traditions and established systems for measurement of land and demarcation of boundaries was not 

behind the rest of the world at any time in our history. Some parts of an ancient system of irrigation, 

consisting of a well-knit pattern of irrigation tanks, feeding canals and distributor channels, are still in 

constant use indicate that surveying in some form was practiced as an earth science, contributing to the 

economic development of our country, Sri Lanka, in pre-colonial days. 

 

In the period of Dutch occupation of Ceylon, they had a system of Registration of Land which included 

the preparation of a survey plan of the land. The registrations were noted in volumes called „tombos‟ 

and they specified the bounds of the land as determined by the Surveyor.  

 

Systematic land surveying began in Sri Lanka after establishment of Survey Department in the year 

1800, while Surveying Profession in Sri Lanka became legally recognized in 1889, paving the way for 

the emergence of the licensed surveyor. Most of the surveys carried out by Survey Department during 

first fifty years were confined to preparation of title plans for land sales. The details contained in the 

first title plan prepared by Survey Department are nearly identical with the information provided in 

statuary plans at present.  

 

Presently, the department is well equipped with latest technology. The strength of the department is 

exceeding about 6000 staff including technically qualified and dedicated personnel in above fields. 

 

Surveyor General is the head of the department and head of the Surveying and Mapping profession. He 

/ She is the Chairman of the Land Survey Council (established under the Survey Act No: 17 of year 

2002) which having legal mandate to regulate private Surveyors in Sri Lanka. 

 

During the last 221 years, under the leadership of 51 Surveyor Generals, as the National Surveying & 

Mapping organization and as an initiative activator in any land development activity of the country, 

Survey Department has earned much acclaim for preparation of plans, maps and Land/Geo Information 

in high quality using up to date technology available. 

 

Global Surveyors Day will highlight the importance of a surveyor, their job and the field work to 

society all over the world. The role of Surveyors is important for the nation. Private and public sector 
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Surveyors must have good co-operation and co-ordination to prepare scientific maps and accurate data, 

needed for the implementation of various projects for the benefit of the people. 

 

The Council of European Geodetic Surveyors represent and promote the interests of the geodetic 

surveying profession in the private and public sector in Europe. Nearly 100,000 professional surveyors 

are members in this Council. 

 

The National Society of Professional Surveyors (NSPS) is the voice of the professional surveying 

community in the United States and its territories. Nearly 45,000 professional surveyors are members in 

this Society. 

  

FIG is an international organization representing the interests of surveyors worldwide. It covers the 

whole range of professional fields within the global surveying, geomatics, geodesy and geo-information 

community. It provides an international forum for discussion and development aiming to promote 

professional practice and standards.  It is an UN-recognized non-government organization (NGO), 

representing more than 120 countries throughout the world. 

 

By the initiative of the Council of European Geodetic Surveyors and the National Society of 

Professional Surveyors with the endorsement of FIG the Premiere celebration of Global Surveyors' Day 

2018 was held at the World Bank Headquarters in Washington, DC., exactly in the middle of the Land 

and Poverty Conference. As part of the celebrations initiated by FIG, a Round Table was organized to 

enable surveying professionals to discuss important topics in today‟s world, followed by an evening 

reception in Washington DC. At the same time the Global Surveyors' Day - website was    launched. 

 

Several other countries, regions and organizations also held events and celebrations on that day in 2018. 

Surveyors are very honored and thankful that the World Bank agreed to host the Premiere event.  

 

Female surveyors in Surveying Profession 

 

The first known American land surveyor was Alice Fletcher. She worked in mid 1800s. In the early 

1900s, women made their first official move into the surveying industry.  Irene Barclay became the 

UK‟s first female Chartered Surveyor in 1922, qualifying only 3 years after the removal of the Sex 

Disqualification (Removal) Act 1919. The first female Surveyor General was Ms. Underwood in 

Australia. She was appointed as Surveyor General of New South Wales, at the age of 32, on 4
th
 of 

October 2016. 

 

In 1980, 2
nd

 of January, 25 young women were 

recruited to the Sri Lanka Survey Department to train 

as lady surveyors. Many people opposed this 

recruitment.   In 1983, 1
st
 of February, Mrs. L.L.S.R. 

Gunasekara, was appointed as the first female 

Assistant Superintendent of Surveys in the Survey 

Department. She left the department very early to 

emigrate to Canada. 
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First Female Surveyor General of Sri Lanka was Mrs.A.L.S.C. Perera. She was the 50
th
 Surveyor 

General of Sri Lanka too.  

 

She joined the Survey Department, on the 1
st
 of 

March 1985, as Assistant Superintendent of Surveys. 

She became the country‟s first female Surveyor 

General in February 2020 after 35years of service in 

the department and retired on 31
st
 of May 2021. It 

was a new look at the Survey Department. In turn it 

was a new look at the Surveying Profession in Sri 

Lanka. 

 

 

 

 

Calendar – Surveying / Surveyors’ Day around the world 

  

 USA is not only celebrating one day, but since 1984 the third week of March has been 

dedicated National Surveyors Week to recognize and promote the many contributions 

by surveyors and the surveying profession in all aspects of life. Nearly 45,000 surveyors are 

practicing in the USA.  

 

 The Council of European Geodetic Surveyors (CLGE) launched its first day of the European 

Surveyor in 2012, on 5
th
 of March, on the 500th anniversary of the Flemish geographer and 

cartographer Gerardus Mercator‟s birth. Now the Council celebrates Global Surveyors‟ Day on 

21
st
 of March.  

 

 10th April is celebrated as 'Survey Day' throughout India. This day has a special significance 

in the History of Surveying in India as it is on this day that Major William Lambton started the 

GTS (Great Trigonometrical Survey) and the work of measurement of the Great Arc from 

Cape Comorin to Bangalore, on 10th April 1802. 

 

  19 June – Philippine National Geodetic Engineers Day 

  9 June –Germany Day of Geodesy. 

  3 June– Japan Surveying day. 

  July 1
st
, Mexico National Day of the Engineer  

  24 June Colombia Day of the Surveyor. 

 The second Saturday in March is Land Surveyors Day in Ukraine. Land Surveyors Day is 

annually celebrated since 2000. The most notable surveyors are presented with prizes, gifts and 

awards. 

 

Still several countries celebrate that their National Surveyors‟ Day on a day of special significance to 

them. Now is changing and they will also start to celebrate March 21
st
, Global Surveyors Day.  
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Declaration of Surveyors’ Day in Sri Lanka 

 

Approval of the Cabinet had been previously granted in 2011 to declare 02nd of August as the National 

Surveyors' Day in Sri Lanka. It is the day the Sri Lanka Survey Department was established. As the 

International Federation of Surveyors, declared 21st March every year as Global Surveyors' Day, a 

proposal made in 2018 by the Minister of Lands and Parliamentary Reforms, to change this date and to 

declare 21st of March every year as Surveyors' Day of Sri Lanka. This proposal was approved by the 

Cabinet. Hence, from 2020 onwards the Surveyors‟ Day in Sri Lanka is on 21
st
 of March.   

 

The Surveyors Institute of Sri Lanka (SISL) initiated and commemorated the first National Surveyors 

Day on 2
nd

 of August 2011 on a large scale. No celebration in 2012. One of the Licensed Surveyors 

wrote an article in the Sinhala newspaper in 2012. On 2
nd

 of August 2013, 3
rd

 anniversary of National 

Surveyors Day was celebrated on a large scale by SISL. Former Hon. Minister Basil Rajapaksa was the 

Chief Guest at the function in 2013. I attended this function as Surveyor General. Thereafter, no 

National Surveyors‟ Day celebration was organized by SISL.  Homagama Surveyors' Association 

organized a seminar and dinner to celebrate the 8
th
 National Surveyors‟ Day on 2

nd
 of August 2018. No 

celebration in 2019. 
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Surveyors’ Day 2020 

 

It was planned to celebrate this day on 21
st
 of March 2020. The program was organized in two parts: 

first the inauguration function and the second session were the technical and panel discussion. At the 

inauguration function it was decided to release “First Day Cover” to commemorate the Surveyors‟ Day 

2020. Later this program was cancelled due to Covid-19.  As the situation improved towards normal in 

September 2020, the “First Day Cover” was released on 22
nd

 September 2020 by the Minister of Lands. 

Surveyors‟ Day 2021 was not celebrated on 21
st
 of March 2021 due to the situation prevailed in the 

country. 

 

 
 

The above information shows that the Surveyors‟ Day has not been celebrated annually in Sri Lanka. 

No one knows why it is not celebrated annually. Lack of funds or lack of interest or lack of 

coordination or something else. My question is how to ensure the sustainability of this program every 

year.  

 

How to ensure sustainability? 

 

One has to understand that sustainability requires long term planning. You should know how we can 

celebrate this day annually. If you have thoroughly thought of how and what you will do in the long 

run, half your work is done. Once you know the long-term vision, you can easily draft the various 

actions required to achieve it. 

 

A major step to ensure sustainability is the involvement and participation of key stakeholders in the 

program. You have to initiate multi-stakeholders‟ dialogue / discussions to involve relevant people in 

your annual program.  

 

We have celebrated Surveyors‟ Day since 1938. Can you believe that?  It is an unofficial Surveyors‟ 

Day. Once a year, in March, surveyors used to have a get-together at the Institute of Surveying and 
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Mapping (ISM), Diyatalawa with sports activities and games. The Celebration starts in an unusual way, 

no assembly, no Chief Guest and no opening ceremony. On the first day of the celebration, surveyors 

and their families, licensed surveyors and families and their friends come from various parts of Sri 

Lanka to participate.  The first two days‟ events are Volley Ball, Indoor games, Billiards, Badminton, 

Basket Ball, Tennis, Net Ball match, athletic games etc. These matches are very interesting and 

thrilling, because family members, friends and elderly people participate in these events. 

 

On the night of the second day, surveyors celebrate Club Night. It is a very interesting and funny night. 

Several programmes are organised; musical chairs, tombola, drama, musical show, children‟s events 

and ladies‟ events.  It provides a lot of fun to the spectators. On the third day morning at 6.00 AM is a 

Marathon race for Ladies and Gents. 

 

After this event, all of them proceed to the Play Ground to have Cricket Matches, Pillow Fight, Foot 

Ball matches and fancy-dress parades etc. There is a tug of war which is a highly exciting event. The 

spectators continuously cheer the participants. While these events are going on, free-Barrel Beer will be 

provided for all members and their families who want to enjoy the chill.   Cap or t-shirt or both will be 

distributed to all at concession prices. Third day‟s night all members organise a Procession to visit all 

residences at ISM to conclude the celebration. One of the members dresses like “Poosari” to take the 

lead of the Procession.  It is very interesting. My question is, why don‟t you make on these days as a 

Sri Lankan style Surveyors‟ Day to keep the sustainability.   

 

Further Surveyors‟ Day is not only for Surveyors. It is for undergraduate surveyors too. They can 

celebrate at university level. All surveying companies should support this event to make the profession 

visible to the public. 

 

“Making Invisible, Visible” 
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Automatic updating of manually updating version of Eset end point Security 

Antivirus 

Mr. E.M.D.M. Ekanayake, Senior Deputy Surveyor General (Mapping) 

____________________________________________________________________________________ 

 

Department has been using commercially available “Eset End point Security” programme (AVP) as a 

Antivirus and Internet Security solution for computers available in the Department. However, 

Department has purchased few licenses with  online updating facility and more licenses with off line 

updating facility due to financial constraints. In order to update the AVP of offline computers, it is 

required to copy “eset update” folder located in C: drive of computer with online updating facility and 

past to the c: drive of computer with off line facility.  

 

But it is found that the  AVP of most of computers installed off line updating facilities are not updated 

regularly or not at all due to the requirement of human intervesion for this process. Lack of interest as 

well as lack of knowledge about the process of updating the AVP have  become the main reason for this 

situation. Disclosing computers to the internet without updating their AVP regularly has badly affected 

to the day to day work of the office. The automation of the manually updating process, using freely 

available software namely SyncBackFree which can be downloaded from 

https://www.2brightsparks.com, has overcome this  situation. The detailed description of the process is 

indicted below.   

 

1. Right click on esetupdate folder located in the C: drive of computer where manually updating 

version of Eset End point Security Anti Virus programme has been installed. Select properties   

and click on “ Sharing” tab to get the following screen. 
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2. Select “Advance Sharing” tab to go to following screen   

      

 

 

                             

 

 

 

 

 

                       

 

 

 

 

 

 

 

 

3. Click on “ permission” tab to get the following screen 
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4. Select “ Everyone” under ” Group or user Names” and put a tick under “Allow” against “ Full 

control” in Permission for Every one area and click “OK”. Click “ OK” for next screen and “ 

Close” the next screen.  

 

 

            

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Then Right click on “My computer” and select “ Map Network drive” to get the following 

screen. 
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6. Expand the drop down menu against the Folder to select the shared folder as shown below. 

           

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Put a tick in “ Reconnect at sign-in” box and click on “ Finish” 
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8. Then go to the Computer where automatic updating version of the Eset End point security Anti 

Virus programme has been installed. Right click on SyncBack_Setup.exe file and select the 

option” Run as administrator” to Install SyncBackFree  software with administrative rights.  

 

 

 

         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Accept the agreement and select “Next” 

 

 

 

 

         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



භැනුම් ඿ඟයා඼        epy msitr; rQ;rpif   SURVEY JOURNAL                     

 

 
Page | 13  

 

10. Select option “ Launch SyncBackFree” and enter “Finish” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. Open SyncBackFree to get the following screen.  
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12. Select “new” under profiles tab.  

 

 

13. Then enter name under profile name and select “Next”. 
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14. Select “Mirror” and then “Next” to get the following screen. 

 

 

            

15. Leave default settings and select “Done” and “OK” for the next screen to get the following 

screen. 
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16. Then select source as eset update folder located in the C: drive of the computer which has been 

installed automatic updating facility of the “Eset End point Security” AntiVirus programme.  

    

 

 

17. Click on “Select Folder” Tab to get the following screen. 
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18. Click “Destination” tab and select eset update folder of the computer over the Local Area 

Network where manual version of the Eset End point Security Antivirus programme have been 

installed as shown below.  

 

       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

19. Click on “Select Folder” tab to get the following screen. 
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20. Select “Apply” and “OK” in next three screens and “Yes” to the final screen to get the 

following screen. 

 

21. Click on “Continue Simulation” for the next screen             
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22. Select the relevant profile by clicking on the profile name and select “Schedule” tab and then 

“Ok‟ for the next screen, to set updating frequency and other settings required to automatically 

update the “eset update” file of the computer with manual updating version of the Antivirus 

programme has been installed, to get the following screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

23. Select default settings under “Security” tab and click on “Repeating” tab. Tick on check boxes 

for section of options “Run this profile for every” and “Indefinitely”. Set only 1 hour in the first 

row as shown below. 
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24. Click “OK” for all screens to get the following screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

25. Select “Run” to get the following screen 
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26. Select “Continue Run” and “Yes” in the next screen for following screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

27. Last successful run time and Next run time can be seen in the screen below.  
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භැනුම්  වා සිතිඹම්කයණයේ ති඿ ්තුන් ඼඿යක අත්දැකීම් (වතය඼න යකොට඿) 
එ඿්. යේ. විජඹසිංව භඹා  -  විශ්‍රාමික ක අතිය ක ඿ යේඹ  ජනයාල් 

____________________________________________________________________________________ 

 

4.1. යෙත්‍ර ුහුණුව඼  : යද඼න යකොට඿ 

භැනුම් වා සිතිඹම් ගතකිරීයම් ආඹතනයේ උ඿඿් ඩිප්යරෝභා ඳාඨභාරා඼ අ඼඿න් වීයභන් ඳසු඼ කලින් අ ධඹේ 

නිභකර යෙත්‍ර ුහුණුවයේ යද඼න යකොට඿ ඿඲වා අනුුකේත යකුනයන් කුුනණෑගර ිස඿්්‍රිේකයේ යගොකල්ල්ර 

ප්‍රයශලඹටි.. සුුහුනු  ඳිදිස ිසඹතරා඼ සිට කුුනණෑගර දේ඼ා ු ම්ිදයඹන් ප්‍ර඼ාවනඹ කයන රද බාන්ඩ 

යදඳා තයම්න්තු ඼ාවනඹකින් යගොකල්ල්ර ප්‍රයශලයේ කුලිඹට ගත් කුඩා නි඼඿ට යගනඹන රදී. ු ම්ිදයඹන් එ඼න 

රද බාණ්ඩ කුුනණෑගරට ඳැමික යණන යතේ ිසන කිහිඳඹේ ු ම්ිදඹ යදඳා තයම්න්තුයේ ය඿ේ඼ඹ කර එ඼කට 

කුුනණෑගර ු ම්ිදඹ ඿්ථානයේ නිර නි඼ා඿ඹක ඳිසංචි඼ සිටි භයේ ඳා඿ැල් මික තුයයකුයේ නිර නි඼ය඿ේ න඼ාතැන් 

ගතිමු. යභ඼ය අඳ කණ්ඩාඹයම් එේ එේ අඹ එේ එේ ඿්ථාන ඼රට අනුුකේත කය තිබ෕ ඵැවින් ක඲වුුන කම්කුන 

඿භඟ සිඹළු කටුකතු තනි඼ කයයගන ඹාභට සිු විඹ. යදඳා තයම්න්තු඼ට ඵැඳුුව ඳසු ප්‍රථභ ඼යට තනි඼භ කටුකතු 

කයයගන ඹාභට සිු ව෕ එභ අ඼඿්ථා඼ එේ අතකින් තයභක අභියඹෝගඹේද විඹ. යගොකල්ල්ර ප්‍රයශලයේ ඳිසංචි඼ සිටි 

යජයේ඾්ඨ යජයේ මික නින්යදෝුන ඼යයඹකු එවිට ඿වාඹට සිටියේඹ. යාජකාිද කටුකතු ඿඲වා යභන්භ යඳෞශගලික 

අ඼ලයතා ඿඲වාද හුණයගන් රද උඳයද඿් භයවෝඳකාරී විඹ. එ඼ය භා ය඼ත ඳැ඼රී තිබුයන් යදඳා තයම්න්තු 

බා඾ාය඼න් විකී ණ භැනුම් යර඿ වඳුන්඼නු රඵන (sporadic ) භැනුම් කිහිඳඹකි. 

යභහිදී  වියලේ඾යඹන් ඿඲වන් කරුකතු කුනණේ නම් ඿ාභානය ඿ම්ප්‍රදාඹ  ය඼න඿්඼ ඹමික න්, යභභ ුහුණුව කාරඹ 

තුර භයේ අධීේ඾ණ කටුකතු සිු කයන රශයශ කුුනණෑගර ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී ඼යඹා විසින්භඹ.එභන්න් 

හුණ, භැනුම් කටුකතු ුහුණුව කයන අතය තුය අධීේ඾ණ කටුකතුද ුහුණුව කයන රදී.                         

4.2. නිතය තනතුය  යාජකාිද ඼රට අනුගත වීභ ඿ව භාඑළියේ ජීවිතඹ 

යම් ඼නවිට යදඳා තයම්න්තුයේ ය඼නත් මික නින්යදෝුන කණ්ඩාඹභේ  (survey party) අනුුකේත඼ සිටි 

කුුනණෑගර ිස඿්්‍රිේකයේභ “භාඑළිඹ” කා ඹාරයේ අධීේ඾ණ නිරධාිද ුහයප්ඳාඩු඼ේ ඇතිව෕ අතය භා඿ 3 කින් 

ඳභණ යෙත්‍ර ුහුණුවයේ යද඼න යකොට඿ අ඼඿න් කය එභ මික නින්යදෝුන කණ්ඩාඹභ අධීේ඾ණඹ කිරීභට 

තා඼කාලික඼ එභ කා ඹාරඹට අනුුකේත යකිදණ. 

භාඑළිඹ කා ඹාරඹ කරක සිට ඳ඼ත්඼ායගන යගො඿්  ඇත්යත් ඉංග්‍රීසි බා඾ාය඼න් pre fabricated hut යර඿ 

වඳුන්඼නු රඵන පූට්ටු ක඲වුයකඹ. එහි බිත්ති, යදොය ජයනල් යභන්භ ඼වරඹද ඹකඩ ඵට ඿ව ටකයම් තවඩු ඼ලින් 

නිභකය ඇත. ක෕ඩායම් ුකගයඹන් ඳසු඼ ඊට ඼ඩා ඿්ථිය යගොඩනැගිල්රේ යර඿ යභභ පූට්ටු ක඲වුුන 

යදඳා තයම්න්තු඼ විසින් ඳ඼ත්඼ායගන යගො඿් ඇති අතය යභඹ ලිඹන ඼ක඼ානු඼ ඼නවිටත් යභ඼ැනි පූට්ටු ක඲වුුන 

යඵොයවොභඹේ ිස඼ි.න ුහයා ඿්ථාන කිහිඳඹක කා ඹාර යර඿ත් නිර නි඼ා඿ යර඿ත් බාවිත කයි.. ඉ඿්යතොප්ුහ඼ේ, 

඿ාරඹේ, නිදන කාභයඹේ, කා ඹාර කාභයඹේ, මුළුතැන් යගඹේ, ඼ැසිකිලිඹේ ආිසයඹන් ඿භන්විත ව෕ අඳ පූට්ටු 

ක඲වුය  බිභට සි යභන්ති යඹොදා තිබ෕ අතය, විු ලි ආයරෝකයඹන්ද ඿භන්විත විඹ. සිවිලිභේ යර඿ තර අතු ඼ලින් 

඿ක඿න රද ඳැු ුන ආ඼යණඹේ යඹොදා තිබුණි. ඉබ්ඵාගමු඼ සිට භඩගල්ර දේ඼ා ිසය඼න ඵ඿් භා ගඹට මීට  100 

ේ ඳභණ ු ිදන් කුඹුයේ භැද ඿විකය තිබ෕ යභභ පූට්ටු ක඲වුය අ඼ට එතයම් ග඿් යනොතිබුුව ඵැවින් විඹලි කාරඹට 

ඳැ඼ති අකාක උුවසුයභන් ආයේ඾ා වීභට යභභ සිවිලිභ යඵොයවෝ ප්‍රයඹෝජන඼ත් විඹ. අ඿ර පිහිටා තිබ෕ ලි඲කින් 

ජරඹ රඵාගැනීභට වැකි විඹ. ඵ඿් භා ගඹේ අ඿ර ක඲වුය පිහිටා තිබුුව ඵැවින් ගභනාගභනඹ ඳවසු විඹ.  

යජයේ මික නින්යදෝුන඼ුනන් ඳ඿් යදයනේ ඿ව මික නින්යදෝුන඼ිදඹන් යදයදයනේ අධීේ඾ණඹ කිරීභ යාජකාිදඹ විඹ. 

යාජකාිදඹට අඹත් ව෕යේ යභභ මික නින්යදෝුන඼ුනන්, ඒ ඼නවිට රැබී ඇති භැනුම් ඉල්ලීම් ඼ැඩ ඼රට අනුුකේත 

කිරීභ, හවුන් එිසයනදා ඉටුකයනු රඵන ඼ැඩ ප්‍රභාණඹන් පිළිඵ඲඼ ඳරීේ඾ා කය ප්‍රභාණ඼ත් යර඿ ඼ැඩ  කය඼ා 

ගැනීභ, හවුන්යේ භැනුම් කටුකතු ඼ර යතෝයාගත් නිඹැිසඹක නිය඼දයතා඼ඹ යෙත්‍රයේ ඳරීේ඾ා කිරීභ, භැනුම් කය 

අඳින රද පිඹුුන ඼ර නිය඼දයතා඼ඹ ඿ව විවිධ යයගුරාසි ඼රට අනුක෕රතා඼ඹ ඳරීේ඾ා කය එභ පිඹුුන ඿ව අදාර 
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ලිපි යල්ඛන යගොනු඼ ඿ම්භත කිරීභ ආිසඹ යේ. එඹට අභතය඼ හවුන්යේ ඿ව හවුන්ට අනුුකේත඼ සිටි එ඼කට 

වැඳින්ව෕ ඳිදිස භැනුම් කම්කුන඼න්යේ ඳිදඳාරනඹද යාජකාිදයේ යකොට඿ේවිඹ. භා විසින් ඳරීේ඾ා කය ඿ම්භත 

කයන රද පිඹුුන, කුුනණෑගර ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී ඼යඹායේ ඼ැඩිු ය ඳරීේ඾ණඹට රේ඼න අතය හුණයේ 

අනුභැතිඹ රැබීයභන් ඳසු඼ නීතයානුක෕ර පිඹුයේ ඵ඼ට ඳත්යේ.  

 එ඼කට කුුනණෑගර ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී ඼යඹා, ිසඹතරා඼ භැනුම් වා සිතිඹම්ගත කිරීයම් ආඹතනයේ 

මුල් ඼඿ය  ුහුණුව඼ රඵන ඼ක඼ානුයේ අඳ වට යශලකයඹකු යර඿ කටුකතු කයන රශයදේ විඹ. හුණ දේ඾ 

නිරධාිදයඹකු, දේ඾ ඳිදඳාරකයඹකු, දේ඾ කශභණාකුනය඼කු යභන්භ දේ඾ යශලකයඹකුද විඹ. නීති යයගුරාසි 

පිළිඵ඲ ව඿ශ දැනුභකින් ුකේත විඹ. භැනුම් කටුකතු කිරීයම්දී තාේ඾ණඹ පිළිඵ඲඼ යභන්භ නීති යයගුරාසි 

පිළිඵ඲඼ද යවො඲ දැනුභේ තිබිඹ ුකතුඹ. ඒ අනු඼ ඵරන කර, ප්‍රථභ ඼යට අධීේ඾ණ යාජකාිද කටුකතු කිරීයම්දීභ 

දේ඾ නිරධාිදයඹකු ඹටයත් කටුකතු කිරීභට රැබීභභ බාගයඹේ විඹ. මික නින්යදෝුන ඼ුනන්යගන් ඼ැඩ ගැනීභ හුණ 

විසින්භ කශභනාකයණඹ කශ අතය භාවට ඉතිිද ව෕යේ හවුන්යේ භැනුම් කටුකතු ඼ර යතෝයාගත් නිඹැිසඹක 

නිය඼දයතා඼ඹ යෙත්‍රයේ ඳරීේ඾ා කිරීභත්, භැනුම් කය අඳින රද පිඹුුන ඼ර නිය඼දයතා඼ඹ ඿ව විවිධ යයගුරාසි 

඼රට අනුක෕රතා඼ඹ ඳරීේ඾ා කය එභ පිඹුුන ඿ව අදාර ලිපි යල්ඛන යගොනු඼ ඿ම්භත කිරීභත් යේ. මුල් ුකගයේ භා 

විසින් ඿ම්භත කයන රද පිඹුුන කුුනණෑගර ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී ඼යඹායේ ඳරීේ඾ණඹට රේවීයභන් 

ඳසු඼ හුණ විසින් වඳුනාගත් ඹම් ඹම් අඩුඳාඩු නි඼ැයිස කිරීභ ඿඲වා ආඳසු එ඼නු රැබ෕ අතය ක්‍රභ ක්‍රභයඹන් ඼ැයිස 

ප්‍රභාණඹන් අඩුවී ඼඿ය අ඼඿න් ඼නවිට කිසිභ අඩුඳාඩු඼ේ වඳුනාගත යනොවැකි ඼න තයම් නි඼ැයිස඼ පිඹුුන ඿ම්භත 

කය ඹැවීභට වැකිවිඹ. ඒ හුණ වඳුනාගන්නා රද ඼යදේ නැ඼ත සිු යනොවීභට කටුකතු කිරීභ නි඿ාත් වඳුනාගත් 

඼යදේ නි඼ැයිස කිරීභට යඳය ඒ පිළිඵ඲඼ සිඹළු කුනුව හුණයගන් විභ඿ා අ඼යඵෝධ කයගත් නි඿ාය඼නි. එඹට 

අභතය඼ භා ඹටයත් යාජකාිද කර එයවත් අත්දැකීම් ඵුණර යජයේ඾්ඨ මික නින්යදෝුන ඼ුනන්යගන්ද උගත ුකතු දෑ 

යඵොයවෝවිඹ. ඒ ඿඲වා යඹොදාගනු රැබුයේ ඿ාකච්ඡා භා ගඹි.. භ඿කට ඼යේ ඳභණ එ඼ැනි ඿ාද ඿ාකච්ඡා භයේ 

ක඲වුය දී ඳ඼ත්඼න රද අතය භට යභන්භ එ඼කට න඼කි.න්ටද එභන්න් රඵාගත් දැනුභ යඵයවවින් 

ප්‍රයඹෝජන඼ත් විඹ. 

යාජකාිද ඼ාවනඹේ යනොතිබ෕ ඵැවින් සිඹළු යාජකාිද ගභන් සිු කයන රශයශ ඵ඿් ිදයඹනි. ඼ා඿නා඼කට යභන් 

කණ්ඩාඹයම් සිටි මික නින්යදෝුන඼ුනන්යගන් යදයදයනේ වැය අන් සිඹළු යදනා ඵ඿් ධා඼නඹ කශ භා ගඹේ අ඿ශ 

නි඼ා඿ කුළිඹට යගන තභ කා ඹාශ ඳ඼ත්඼ායගන ඹන රදී. ඵ඿් භා ගඹට කියරෝමීටය 3 ේ යවෝ 4 ේ ු ිදන් ඉවත 

යදයදනායේ කා ඹාර පිහිටා තිබුණි. එභ ු ය ඳි.න්භ ඹා ුකතු විඹ. ඳරීේ඾ණ කලින් දැනුම්යදන රද ිසනඹක 

යඹොදාගන්නා ඵැවින් කණ්ඩාඹයම් කම්කුනය඼කු ඵි.සිකරඹකින් රඟභ ඵ඿් නැ඼තුම්යඳොරට යගන්඼ායගන 

ඹාභට ඳසු඼ ුහුනු  විඹ. භ඿කට ඼යේ භයේ අධීේ඾ණ නිශධාිදඹා ඼න කුුනණෑගර ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී 

඼යඹා ඳරීේ඾ණඹ ඿඲වා ඳැමික ණි අතය එිසනට හුණයේ ඼ාවනයඹන් හුණත් ඿භඟ ගභන් කිරීයම් අ඼඿්ථා඼ උදාවිඹ. 

භා වට ඼ාවනඹේ රැබුයන් කණ්ඩාඹභට ඼ැටුප් යගවීභ ඿඲වා ඹාභට ඳභණි. එකර ඼ැටුප් ඿ව ඿ංුකේ ත දීභනා 

ඇතුළු ය඼නත් සිඹළුභ දීභනා යග඼න රශයශ මුදලිනි. ඼ැටුප් යග඼න ිසන, ඵ඿්යථඹකින් කුුනණෑගර ිස඿්්‍රිේ 

මික නින්යදෝුන කා ඹාරඹ ය඼ත ගභන් කර අතය කණ්ඩාඹයම් මික නින්යදෝුන ඼ුනන් වා ඼ිදඹන්ද එිසනට යල්ඛන 

රඵාගැනීභ ඼ැනි විවිධ යාජකාිද කටුකතු ඿඲වා ිස඿්්‍රිේ මික නින්යදෝුන කා ඹාරඹ ය඼ත ඳැමික මටභට ුහුනු ඼ සිටිඹව. 

උයශභ ඳැමික ණ ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී ඼යඹා වමුවී ඒ ඼නවිට ඳැනනැ ඇ ඇති ගැටළු පිළිඵ඲඼ ඿ං඼ාදඹක 

යඹදී ඼ැටුප් යෙේඳත්ද ල්යගන ඵැංකු඼ ය඼ත ඹනු රඵන අතය ඒ ඿඲වා යජයේ඾්ඨ මික නින්යදෝුන ඼යයඹකුයේද 

඿වාඹ රඵාගනී. ඒ එකර විලාර මුදරේ ව෕ ුනපිඹල් රේ඾ එක වභායේ ඳභණ නි඼ැයිස඼ ගැන කා ඹාරඹට යගන 

ඒභට අ඼ලය නි඿ාය඼නි. ිස඿්්‍රිේ මික නින්යදෝුන කා ඹාරඹ ය඼ත එකතුව෕ මික නින්යදෝුන඼ුනන් සිඹළු යදනා ඿වාඹට 

යගන එේ එේ මික නින්යදෝුන කණ්ඩාඹභට (කම්කුන඼න් ඇතුළු඼) යගවිඹ ුකතු මුදල් ය඼න ය඼නභ ක඼ය ඼රට 

ඵවා වැකි ඉේභනින් ආඳසු ඹාුකතු යේ. ඒ අඳ ඳැමික යණන යතේ මික නින්යදෝුන කණ්ඩාඹම් ඵරා සිටින ඵැවිනි. 

එකර, අඳ ය඼ත යදඳා තයම්න්තුය඼න් යාජකාිද ගභන් ඿඲වා රඵා දී තිබ෕ වම් ඵෑගඹට ඼ැටුප් ඿හිත ක඼ය දභා 

නගයයේ යට බීභ වයරන් ගත් යඵෝතරඹකුත් එභ යාජකාිද භල්රටභ දභායගන කුුනණෑගර සිට භාඑළිඹ යද඿ට 

ඹායම්දී මුලින්භ ඳසුකයන්යන් මික නින්යදෝුන඼ිදඹන් යදයදනායේ කා ඹාරඹන්ඹ. එභ කණ්ඩාඹම් යදකට ඼ැටුප් 

ක඼ය රඵාදී අත්඿න් රඵාගත් ඳසු඼ අඳයේ කරඵරඹ අ඼඿න්ඹ. ඊ රඟට වේ඼ටුණා හඹ ඳාරභ ඳසු කයශදී හයේ 
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ජරඹ පිරී ඇත්නම් ඼ාවනඹ ඳය඿ක න඼ත්඼ා ුනපිඹල් රේ඾ඹකට අකාක මුදරේ අඩංගු වම් ඵෑගඹ ඼ාවනයේ 

යකොතැනක යවෝ ඿ඟ඼ා ඿්නානඹ කයනු රැයබ්. එය඿ේ භඟිසගට ඼ැටුප් ක඼ය යඵදමික න් යගො඿් ගභන නිභ඼න්යන් 

ු ය඿්ථභ මික නින්යදෝුන඼යඹා සිටි යභොයයගොල්රාගභ නම් ඿්ථානයේිසඹ. ඒ ඼නවිට ය඼රා඼ තීයණඹ ඼න්යන් 

භඟිසගට රැයඵන ඿ංග්‍රව අනු඼ඹ. ඿භවය ිසන඼ර ිස඼ා ආවායඹ ගන්නාවිට ඿඼඿ වඹ යවෝ වත ඳභණ විඹ.  

4.3 සිඹමරාණ්ඩුයේ ජීවිතඹ. 

1987 ඼඿ය  අනුුකේත කය තිබුයන් එ඼කට අති ු ඾්කය ය඿ේ඼ා ඿්ථානඹේ ව෕ යභොණයාගර ිස඿්්‍රිේකයේ 

සිඹහරාණ්ඩු඼ ප්‍රයශලඹටඹ. සුුහුනු  ඳිදිස ු ම්ිදයඹන් ඵු ල්ර දේ඼ා බාණ්ඩ ප්‍ර඼ාවනඹ කය එතැන් සිට යට්රයඹේ 

඿හිත ජීප් යථඹකින් සිඹහරාණ්ඩු඼ට ප්‍ර඼ාවනඹ කයන රදී. ඒ ඼න විට කිහිඳ ඼යේ ු ම්ිදයඹන් බාණ්ඩ ප්‍ර඼ාවනඹ 

කය තිබුනු ඵැවින් ඵඩු යඳොිස ඵැඳීභ ඿ව ප්‍ර඼ාවනඹ පිලිඵ඲ භනා අත්දැකීභේ අඳට යභන්භ අඳයේ ක඲වුුන 

කම්කුන඼න්ටද රැබී තිබිණ. 

සිඹමරාණ්ඩුයේදී න඼ාතැන ඿ව කා ඹාරඹ ඳ඼ත්඼ා යගන ඹාභ ඿඲වා මුතුකණ්ඩිඹ ඼ාිදභා ග යඹෝජනා ක්‍රභඹට 

අඹත් කුඩා නි඼඿ේ යතෝයාගන්නා රදී. යාජකාිද ජීවිතයේ මුල් ඼යට අඳ කණ්ඩාඹභටභ ය඼න්වු ජීප් යථඹේද  

රැබිණ. ඇයභිදකන් ජීප් නමික න් වඳුන්඼න රද එභ යථයේ ඼ ගඹේ දැන යනොසිටි අතය ඼වරඹ කැන්඼඿් යයශදකි. 

එ඼ක අද යභන් යනො඼ භා ගඹ ඉතා අඵරන් තත්ත්඼යේ ව෕ ඵැවින් යභොණයාගර සිට කියරෝ මීටය 40 ේ ඳභණ ව෕ 

ගභනට ඳැඹ එක වභායේ ඳභණ ගත විඹ. ඉන්ධන රඵාගැනීභ ඿඲වා ඳ඼ා යභොණයාගරට ඹාුකතු ව෕ ඵැවින් 

නිතයභ ඳායවේ යභොණයාගර නගයඹට ඹාභ සිිදතේ විඹ. ඉන්ධන රඵාගැනීයම් සීභා ඳන඼ා යනොතිබුුව අතය 

ඇනවුම් භන්න් ඉන්ධන රඵාගතුකතු විඹ. ජංගභ ු යකථන යනොභැති එකර ු යකථන ඇභතුභේ රඵා ගැනීභට ඳ඼ා 

යභොණයාගර නගයඹට ඹාුකතු විඹ. අම්ඳායට ඇත්යත් කියරෝ මීටය 50 කි. ඼ාවනඹ අළුත් ඼ැඩිඹා කටුකතු ඿඲වා 

යඵොයවෝ අ඼඿්ථා ඼ර කියරෝමීට  50 ේ ඳභණ ු ිදන් අම්ඳාය  පිහිටි ඼ාිදභා ග යදඳා තයම්න්තු ඹාන්්‍රික 

඼ැඩයඳොර ය඼ත ඹ඼ා එභ අළුත්඼ැඩිඹා඼න් ඉටුකයගන්නා රදී.  

යදඳා තයම්න්තු඼ට ඵැඳීභට යඳය සිටභ භා වට යවොඳින් ඼ාවන ධා඼නඹ කරවැකි ව෕ අතය ිදඹැු ුන ඵරඳත්‍රඹද 

රඵායගන තිබුණි. එකර නිරධාිදන්ට ඼ාවන ඳැදවීභ තවනම් ුකගඹකි. ඼ාවනයේ ිදඹැු ුන භවතා තයභක ඼ඹ඿් 

ගත යභන්භ අණ්ඩඳාරයඹේ ඵ඼ ඉේභනින්භ ඼ැටුණනු අතය යාජකාිද ගභන් ඹා වැකි඼ තිබුයන් භට අ඼ලය 

අ඼඿්ථායේ යනො඼ ිදඹැු ුනට අ඼ලය ය඼රා඼ටඹ. ගාල්ර ප්‍රයශලයේ ඳිසංචි ුහශගරයඹකුව෕ හුණ සිඹමරාණ්ඩු඼ ඼ැනි 

ු ඾ක්ය ඳරාතක ය඿ේ඼ඹ කයන ඵැවින් ඿ව භට ඼ඩා ඼඿ය ගණනා඼ේ ඼ඹසින් ඼ැඩි ඵැවින් අ඼඼ාද යවෝ දඞු඼ම් 

කිරීභද සුු සු යනොයේ. එය඿ේ වු඼ද හුණ භයේ උඳයද඿් ඹටයත් කටුකතු කයනු විනා භා හුණ ඹටයත් කටුකතු කර 

ුකතුද යනොයේ. ිසනේ කලින් යඹොදාගත් ගභනේ ඿඲වා ප්‍රභාදවී ඳැමික ණ ගභයන් යඹයදන අතය “භයේ යාජකාිදඹ 

හඵට කරවැකිද ?” කිඹා භා විභස෕විට හුණ ඳැ඼සුයේ “කිසිය඿ේත්භ කර යනොවැකි” ඵ඼ඹ. භයේ ප්‍රතිොයඹ ව෕යේ 

“භට හඵයේ යාජකාිදඹ ඿ව භයේ යාජකාිදඹ ඹන යදකභ කරවැකි” ඵැවින් භා රඵායදන උඳයද඿් අනු඼ 

ය඼රා඼ට යාජකාිදඹ ඿඲වා ඼ා තා කර ුකතු ඵ඼ි.. එභ සිශකායඹන් ඳසු඼ නිඹමික ත ය඼රා඼ටත් කලින් හුණ 

ඳැමික මටභට ුහුනු  විඹ එ඼කට යභොණයාගර මික නින්යදෝුන කණ්ඩාඹභ බාය඼ සිටියේ අඳට කණ්ඩාඹම් යදකකට 

යඳය ඵැඳුුව, ඳසු කයරක ඿ යේඹ  ජනයාල් ඳදවිඹටද ඳත්ව෕ අයඹකි. හුණ න඼ාතැන් යගන සිටියේද 

යභොණයාගර ිස඿්්‍රිේ මික නින්යදෝුන කා ඹාර ඳිදශ්‍රයේභ පිහිටි ටකයම් ඼ලින් ඿ාදන රද යඳය඿වි නි඼඿කඹ. 

යභොණයාගර ගිඹ යඵොයවෝ ිසන඼ර හුණයේ ආගන්තුක ඿ත්කාය රඵමික න් එහි යා්‍රිඹේ ගත කිරීභ සිිදතේ඼ 

ඳැ඼තුනි. ඿඼඿ට බිඹ  යඵෝතරඹකින්ද ඿ප්ඳාඹම් වී යා්‍රි ආවාය ගැනිභ යභොණයාගර න඼තින ිසනඹක, ිසන 

ෙ ඹායේ ඿ාභානය අංගඹේ විඹ. 

සිඹමරාණ්ඩු඼ මික නින්යදෝුන කණ්ඩාඹභ මික නින්යදෝුන඼ුනන් 9 යදයනකු ඿ව යෙත්‍ර ුහුණුව඼ රඵන අඳ 

කණ්ඩාඹභට ඳසු඼ ඵැඳුුව ඳිද඼ා඿ කණ්ඩාඹයම් 4 යදයනකුද ඇතුරත්඼ 13 යදයනකුයගන් ඿භන්විත විඹ. 

ඳිද඼ා඿ කණ්ඩාඹයම් 4 යදනා භා඿ කිහිඳඹකින් ිසඹතරා඼ට පිටත්඼ ගිඹ ඵැවින් දී ඝ කාලීන඼ මික නින්යදෝුන඼ුනන් 

9 යදයනකු කණ්ඩාඹභට ඇතුරත් විඹ. ඉතා යජයේ඾්ඨතභ යභන්භ ඉතා කණි඾්ඨතභ නිරධාිදන්යගන් ඿භන්විතව෕ 

සිඹමරාණ්ඩු඼ මික නින්යදෝුන කණ්ඩාඹයම් කණි඾්ඨ නිරධාිදන්ට අ඼ලය උඳයද඿් රඵාදීභ ඿඲වා යජයේ඾්ඨතභ 

නිරධාරීන් යඹදවීභට පිඹ඼ය ගැනුනි. යජයේ඾්ඨතභ නිරධාරීන් යදයදනාභ භැනුම් කටුකතු ඿඲වා අතිලි.න් දේ඾ 
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අ඼ංක඼ ය඿ේ඼ඹ කර නිරධාරීන් ව෕ ඵැවින් හවුන් විසින් රඵායදන උඳයද඿් ඿ව ආද ලඹ න඼ක 

මික නින්යදෝුන඼ුනන්ට යභන්භ න඼ක ඿වකාය මික නින්යදෝුන අකාකාිද ඼යයඹකු ව෕ භටද භයවෝඳකාරී විඹ. 

සිඹමරාණ්ඩු඼ කණ්ඩාඹයම්දී ඿ම්භත කයන රද පිඹුුන එකේ ඼ත් මික නින්යදෝුන අකාකාරී විසින් ඳරීේ඾ා කිරීයභන් 

ඳසු඼ ඿ංයලෝධන ඿඲වා ආඳසු යනොරැබුුව අතය, ඒ ඒ඼ායේ ඇති නිය඼දයතා඼ඹ නි඿ාද නැතයවොත් ඼ැඩිු ය 

ඳරීේ඾ා඼ට රේ යනොකර නි඿ාද ඹන්න ඳැවැිසලි නැත. 

සිඹමරාණ්ඩු඼ මික නින්යදෝුන කණ්ඩාඹයභහි යාජකාිද බායගත් මුල් ිසන඼ර කණ්ඩාඹම් ඳරීෙණඹේ (Group 

Inspection) ඿඲වා ිස඿්්‍රිේ මික නින්යදෝුන අකාකාරී සිඹමරාණ්ඩු඼ට ඳැමික ණිභට නිඹමික ත඼ තිබිණ. සිඹමරාණ්ඩු඼ 

මික නින්යදෝුන කණ්ඩාඹයභහි යාජකාිද බායගත් ඳසු඼ ඳැ඼ැත්ය඼න ඳශමු ල්඿්වීභ ඵැවින් ඿ව එිසනට කණ්ඩාඹයම් 

සිඹළුභ යදනා එකට වමු඼න ඵැවින් යවො඲ ිස඼ා ආවාය යේරේ ස෕දානම් කරුකතු විඹ. එකර, කුකුල් භ඿් 

඼යංජනඹේ  ඹනු වියලේ඾ අ඼඿්ථා඼කදී ඳභණේ පිළියඹර කයනු රඵන්නකි. විු ලි ඵරඹ යනොභැති සිඹමරාන්ඩුයේ 

ශීතකයණ යනොභැති ඵැවින් යරොි.ර  භ඿් රඵාගත යනොවැක. එයවත් ගම්භාන ඼ර නි඼ා඿ ඼ර ඇතිකයන ගම් 

කුකුශන් සිටින අතය හවුන් ිස඼ාකර ු ඼ ඳැන ඇවිද ආවාය ය඿ොඹා කා යා්‍රිඹට ග඿ක අතුභත නිදාගනී. කැයල් 

වැයදන ඿තුන් ඵැවින් ිස඼ාකර අල්රා ගැනීභ අඳවසුඹ. යා්‍රියේ නිදාගත් කර ඳවසුය඼න් අල්රා ගත වැක. 

කුකුශායේ හිමික කුන඼න්ට යගවීභට අභතය඼, ග඿ට නැඟ අල්රා යදන තැනැත්තාටද සුළු යගවීභේ කර ුකතු යේ. 

15 යදයනකුට ඳභණ ිස඼ා ආවායඹ ස෕දානම් කරුකතු ඵැවින් කුකුශන් යදයදයනකු භාිදඅයා඼ ගයභන් ඳණපිටින් 

යගෝනිඹක දභා යගනැවිත් තිබිණ. කණ්ඩාඹම් ඳරීෙණඹ අ඼඿ානයේ කුකුශ ් භ඿් ඿භඟ ිස඼ා ආවායඹ යගන 

අ඼඿න් විඹ. නිකභට යභන් යගෝනිඹ ඳරීො කිරීයම්දී දකින්නට රැබුයන් ත඼ත් කුකුයශකු යගෝනිඹ තුර සිටින 

ඵ඼ඹ. සිු ඼ ඇත්යත්, ආවාය පිළියඹර කර තැනැත්තන්  දැක ඇත්යත් එේ කුකුයශේ ඳභණි. අවම්යඵන් ඳණ 

යබ්යාගැනීභට වැකිව෕ කුකුශාට අබඹ දානඹ දී මුදාවිදන රද නමුත්, යඵොයවෝ කාරඹේ අඳ න඼ාතැන අ඿ර 

ගැ඼සුනු එභ ඿ත්ත්඼ඹා ඳසුකයරක අතුුනදවන් විඹ. 

එකර යකොශම සිට සිඹමරාණ්ඩු඼ට ඹාභට ඵ඿්යථයඹන් ගභන්කිරීභට ඳැඹ 12 ේ ඳභණ ගතවිඹ. උදෑ඿න 6 ට 

පිටයකොටුය඼න් ආයම්බ කයනු රඵන අම්ඳාය ඵරා ඹන ඿මුද්‍රසිිද නභැති ඵ඿්ිදඹ සිඹමරාණ්ඩු඼ට රඟා඼න්යන් 

඿඼඿ 5.30ට ඳභණඹ. එඳභණ කාරඹේ එකිසගට ඉ඲යගන සිටීභ යවෝ සිටයගන සිටීභද අඳවසුඹ. යා්‍රි 

ගභනාගභනඹ ඳවසු වු඼ත් උඩ඼රයේ ප්‍රයශලයේදී භංයකොල්ර කෑයම් සිශකා ඼ා තාවී ඇති ඵැවින් වැකිතාේ ු යට 

ිස඼ා කාරයේ ගභන් කිරීභ ුහුනශදේ කයයගන තිබින. 

 සිඹමරාණ්ඩුයේදී අත්විඳි ු ඾ක්යතභ කා ඹඹ ව෕යේ බීභට ජරඹ ය඿ොඹා ගැනීභි.. ඒ ඿඲වා උඳයඹෝගී කයගනු 

රැබුයේ යදඳා තයම්න්තු඼ විසින් ඿ඳඹා දී තිබ෕ ජර යඳයණඹි.. එඹ අල්ළු඼ේ යහිත, ඵ඲ භවත, කට කුඩා, 

යජෝගු඼කට ඿භාන ව෕ අතය ඵ඲ පිඟන් භැටි ඼ැනි යඳරීයම් වැකිඹා඼ ඇති ද්‍ර඼යඹකින් නිභ඼ා තිබුණි. යභභ 

යඳයණඹ (යජෝගු඼) ජරයේ ගිල්඼ා තැබීයභන්, වි඿යණඹ නම් ක්‍රිඹා඼ලිඹ භන්න් පිිදසිු  ජරඹ යඳයණඹ තුරට 

එකතු යේ.  

යභභ ජරඹ ඳානඹ කිරීයම් ප්‍රථිපර ඉේභනින්භ අත්විඳීභට රැබුුව අතය, එඹ අ඼඿න් ව෕යේ ඼කුගඩු඼ක ගල් 

ඇතිවීභ නි඿ා ගල් ඉ඼ත් කිරීයම් ලරයක භඹකටද බාජනඹ වීයභනි. අද යභන් යනො඼ එකර ඒ ඿඲වා ඳැ඼ති එකභ 

වි඿ඳුභ ලරයක භඹ විඹ. එ඼කට සිටි දේ඾තභ ලරය ෛ඼දය඼යයඹකු විසින් සිු කයන රද එභ ලරයක භඹට ඳැඹ 

4 ේ ඳභණ ගතවී ඇති අතය ඼කුගඩු඼ට රඟාවී ඇත්යත් දකුනු ඳ඿ තුණටිඹ අඟල් 8 ක ඳභණ ිසගකට කඳා ඉශ 

ඇට ක෕ඩුයේ අන්තිභ ඉර ඇටඹ ඼න එල්ලී ඇති ඉර ඇටඹ (Hanging Rib) කඳා ඉ඼ත් කිරීයභනි. ඉ඼ත් කයන 

රද ගර, වැඩයඹන් ඿ව ප්‍රභාණයඹන් යරොකු ය඼යළු ඇටඹක ඿්඼ූපඳඹ ගැනුනි. ඿ාම්ප්‍රදාඹක භැුණම් යනොයඹදා 

ිසඹය඼න භැුණම් යඹොදා ඇරය඼න යර඿ ඼඿ා ඇති එභ ලරයක භයේ කැශශ අදටද දැකිඹ වැක. එභ 

ලරයෛ඼දය඼යඹා යේ වියලේ඾ත්඼ඹ ඼න්යන් හුණ ප්‍රතිඳත්තිඹේ යර඿ ලරය ක භඹකදී යයෝගියඹකුට ුනකායඹ 

රඵා යනොදීභි.. එයවත් ඒ ඿඲වා ඉතා අයඳිද඿්඿මික න් ලරීයඹ කැපිඹ ුකතු යේ.  

ඉවත ලරයක භයඹන් ඳසු ලරය ෛ඼දය඼යඹා අනුභත කශ අ඿නීඳ නි඼ාඩු කාරයඹන් ඳසු඼ භා඿ඹක කාරඹේ 

඿ැවැල්ලු ය඿ේ඼ා ඳදනභ භත නි඼඿ට නුු ුනභ ිස඿්්‍රිේ කා ඹාරඹ ඼න ගම්ඳව කා ඹාරඹට අනුුකේත කයනු 

රැබීඹ. එහිදී කයන රශයශ ගම්ඳව ිස඿්්‍රිත් ේකඹට අනුුකේත඼ තිබ෕ ඿වකාය මික නින්යදෝුන අකාකාිද඼ුනන් විසින් 
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඿ම්භත කය ිස඿්ත්‍රීේ මික නින්යදෝුන අකාකාිද ය඼ත අනුභැතිඹ ඿඲වා එ඼න රද පිඹුුන ඳරීේ඾ා කය ඒ඼ායේ අඩුඳාඩු 

නි඼ැයිස කය ිස඿්ත්‍රීේ මික නින්යදෝුන අකාකාිද ය඼ත යඹොමු කිරීභි.. එභන්න් පිඹුුන඼ර ඇති ඼ැයිස ඿ව අඩුඳාඩු 

පිළිඵ඲඼ යඵොයවෝ යදඹ ඉයගන ගත වැකිවිඹ. 

4.4 කුලිඹාපිටි ජීවිතඹ 

ඊරඟ ඼඿ය , එනම් 1988 ඼඿ය  ඼ා ෂික ඿්ථාන භාුනවීම් භත නැ඼තත්  කුුනණෑගර ිස඿්්‍රිේකයේ කුලිඹාපිටිඹ 

කණ්ඩාඹභ අධීේ඾ණඹ කිරීභට අනුුකේත යකිදණ. එහිදී කුලිඹාපිටිඹ නගයඹට නුු ුන නි඼඿ේ කුලිඹට යගන 

කා ඹාරඹ ඿ව ඳිසංචිඹ ඳ඼ත්඼ායගන ගිඹ අතය නැ඼තත් භාඑළිඹ කා ඹාරයේදී භයේ ඉවශ නිශධාිදඹා ව෕  

කුුනණෑගර ිස඿්්‍රිේකයේ මික නින්යදෝුන අකාකාරී ඼යඹා ඹටයත්භ නැ඼ත කටුකතු කිරීභට වැකිඹා඼ රැබීයභන් 

යාජකාිද කටුකතු ඿ව දැුවභ ත඼ු යටත් හඳභට්ටම් කය ගැනීභට වැකිවිඹ. 

එයවත් යභභ ය඿ේ඼ා ඿්ථානයේ කටුකතු භා඿ න඼ඹකට ඳභණ සීභා විඹ. 

 

භතු ඿ම්ඵන්ධි....... 
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Concept Paper for ISM Agro-GIS Education and Research Programme 

Mr. N.J.Wijenayake,Senior Deputy Surveyor General (Training)/ Director (ISM) 

 

 

ISM AgroGIS Education and Research Programme 

 

1. Introduction 

 

In far history, during the Great King; Parakramabahu era Sri Lanka, called as “Thambapanni” had been 

prestige with “Peradiga Dhanyagaraya”. This gives us the impression that the country had been 

sustainably developed in the far history, with paddy and agriculture products and the country was self-

sufficient with locally made food. However, since the 19th century, the world society has experienced 

the agricultural revolution to overcome the common truth that death by starvation was not uncommon 

in most part of the world. 

 

In recent history, since a few decades back, national agricultural production in Sri Lanka has been 

declined at a greater scale due to various reasons such as; lack of farmers‟ interest on conventional 

mechanisms, unaware of crop suitability for soil & geological conditions, lack of information systems 

for regional/national crop yield prediction and planning to prepare for better marketing approach etc., 

This bitter truth is being analyzed by the intellectuals in different aspects. However, being the geo-

spatial data specialist and as the pioneer institution in Sri Lanka; Institute of Surveying & Mapping 

(ISM) concerns the matter as a critical issue which needs to consider as the challenge of the era.  

 

Furthermore, Former Hon. Minister of Higher Education; Dr. Bandula Gunawardane, at his visit to ISM 

with Former Hon.Minister of Land; Mr.S.B.Dissanayake accompanied with respective secretaries to 

both the ministries on 6th January, 2020 expressed his willingness to convert the institution to 

university status with the intention of introducing the extended surveying related curriculums in ISM 

academic forum to incorporate the regional social economic parameters for enhancing the regional 

inhabitants‟ living status. Therefore, in concern with the respective regional needs, agriculture as the 

main income of the people in Uva province, the proposed Agro-GIS education and research programme 

would greatly empower the region as a long-run effective project to educate the regional manpower. 

 

With a long term vision to support the national agriculture and irrigation sectors through modern GIS 

and Remote Sensing technology, the Institute of Surveying and Mapping is learning its responsibility 

towards the growth of respective state-of-the-art technology for improved agricultural infrastructure 

planning, livestock management, crop yield prediction etc. Even-though many educational and training 

institutions and also the universities are very much concerned with theoretical aspects of agricultural 

engineering whilst enabling technology, it is the bitter truth that national agriculture is yet being 

functioned with primitive and conventional production tracks. There are various issues in the plantation 

industry that are encountered by the cultivators and also the research institutions due to less awareness 

and lack of applicable mechanism on GIS and Remote Sensing technology. 

 

ISM AgroGIS education and research proposal is planning to begin with initiatives for integrating 

agriculture with GIS and Remote Sensing technology. This research-based, project-oriented educational 

programme aims at the agricultural sector employees and the growers in the region and planning for 

national propaganda.  
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Use of advanced GIS and satellite remote sensing technology in the agricultural sectors is a crucial need 

and a vital challenge of the era for the growth of the national GDP. Therefore, employees in the 

agricultural sector who work with conventional methodologies should be intrigued with possible GIS 

and remote sensing applications. Within the context of enormously developed GIS and Remote Sensing 

technology, ISM as the institution, strengthened with respective technology; realises its responsibility in 

educating the agriculture sectors, taking as the challenge of the era for national growth.  

 

In concern with the Sri Lanka mapping history for hundreds of years, 1-inch map series and 1:50,000 

metric map series had played a vital role in agriculture mapping. Conventional mapping with showing 

of land-use and land-cover patterns with descriptive agriculture related representation had vastly 

benefited the relevant stakeholders. As such, an excellent practice of linking the national agriculture 

and geo-spatial mapping sector, the Agricultural Based Mapping Project (ABMP) launched in the 

1980s, using the highest technology had in that time; aerial photography and stereo map compilation is 

a salient manifestation of best link with the prevailing technologies. 

 

This concept paper proposes the needs of a new approach in the geospatial education forum in order to 

provide prospective GIS and Remote Sensing technology towards the national Agriculture sector 

development and how ISM shall propose to promote a few short courses in the theme of Agro-GIS. 

 

Basic GIS applications shall be customized at the “ISM-Agro-GIS” Project area. The project shall be 

further extended to Kahagolla Agricultural Research farm with related GIS infrastructure development 

in collaboration with respective research staff. As a pilot and research based educational programme, 

both the institutes shall collaboratively utilize the available resources and technologies for improving 

the needs for national research based educational programmes. 

 

Ref; Brief description of “Agro-GIS enabling technology” is annexed for further references. 

 

2 Objectives; 

 

Following objectives are mainly expected through introducing the concerned project proposal. 

 

1. To Promote GIS and Remote Sensing applications in Agriculture sectors for improving the 

national agriculture production 

2. To promote GIS and Remote Sensing based educational and research programmes in ISM 

curriculum. 

3. To Establish and Maintain the Agro-GIS Project site in ISM to develop capacity building 

programmes with practical solutions related to GIS and Remote Sensing. 

4. Build up the knowledge sharing and capacity building programmes among the stakeholders. 

 

 

3. Stakeholders 

 

In concern with national agricultural issues, the proposed project shall be a great impact to facilitate 

GIS and Remote Sensing modern technology towards the prospective stakeholders over the country. 

Therefore project shall be extended to various stakeholders in related fields. However, at the initial 
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stage, following stakeholders shall take part in join collaboration for concept designing and modeling of 

agriculture entities; 

 

 

 Stakeholder Institution Organization 

1 Institute of Surveying & Mapping Survey Department 

2 Regional Agriculture Research & 

Development Centre, Kahagolla  

Agriculture Department 

 

It is expected that various organizations, functioning with agriculture, plantation, livestock farming 

related industries and research institutes will be prospective stakeholder in future directives. 

Furthermore, small scale cultivators and farmers would also be prospective stakeholders as 

representation of the general public. 

 

 

4. Agro-GIS Study Courses 

Few study courses have been designed to conduct within the ISM premises enabling practical training 

facilities at the ISM Agro-GIS project site. Educational curriculums for the respective courses have 

been designed as a collective mission of the academic and research personnel from both ISM and 

Kahagolla Agriculture Research farm. 

Study Courses 

 

 Duration Course Name Course Content 

1 1-Day  Introduction to Agro-

GIS 

GIS thro. Agricultural point of view, 

GNSS and Remote Sensing applications in 

Agriculture. 

Internet and Mobile GIS for Agriculture. 

2 5-Days Agro-GIS Data Science Introduction to Geospatial data, Data 

classification, Data Modeling for Database, 

Spatial Data modelling over agriculture 

theme,  

Location based services, GNSS and Remote 

Sensing applications in Agriculture. 

Detailed course content of each subject and the expected learning outcomes are annexed. 
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5. Agro-GIS Projects Site; 

 

Proposed Agro-GIS education and research programme would become a reality with real time 

application scenarios that provide practicals related with GIS and Remote Sensing data which will be 

dynamically updated from the project site. Hence, ISM has founded a project site within the ISM 

premises and further extended towards Kahagolla Agriculture farm site. 

 

A land about 3-acres as shown in the figure-1, has been allocated and being developed with landscaping 

and planting of pears and Mandarin to the northern side of the ISM premises. The plants have been 

donated by the Kahagplla Agriculture research farm with regards the prospective needs as detailed in 

this submission. In concern with the mutual understanding of ISM staff and the ISM-welfare society, 

Project-site maintenance is continued with financing out of the public funds.  

 

The project site is an ideal landscape with changed elevation above a small stream. Therefore the needs 

in many practical tasks can be arranged to cater for engineering surveying too. It is expected that the 

Agro-GIS training programmes will mainly be based on engineering surveying with geomorphology 

studies. The area was covered with thick jungle and cleared for the same purpose. 

 

Maintenance of the project site shall be conducted by the ISM resource management staff as their 

regular accomplishment. It is worthwhile to state that the project site and the crops belong to ISM 

property and the expected yield would be utilized by the ISM staff as of the instructions by the 

Director-ISM. The Director-ISM shall have the sole authority for upgrading and maintenance of the 

project site. 

 

 

Figure-1; Project Site - Aerial View 
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6. Agro-GIS Sustainability and Motivation 

 

Agro-GIS as a productive solution in agricultural economic growth that will boom the sector in 

following aspects;  

● Basic planning and decision making for land suitability and infrastructure development. 

● Monitoring and management of industrial issues and disaster recoveries.. 

● Marketing strategy formulation. 

● Relaxing over user satisfactory systems and time saving. 

●  

In general, sustainability of any programme is not merely a matter of its importance. Therefore, it is 

necessary to plan for motivation factors. Motivation factors related with the proposed Agro-GIS 

education and research programme can be learned in following aspects. 

 

a. Financing for education and research programme.  

 Related subjects shall be included in ISM educational curriculum so that the study courses will be 

conducted on ISM accepted charge basis. Subsequently, research opportunities will be commenced 

in due course as a cooperative solution with Kahagolla Agriculture Farm sector and other potential 

applications that would be requested by prospective client organizations. 

 

b. Adaption of Agro-GIS related modern technology. 

Prospective improvement of GIS technology and agriculture related applications should be 

continuously adapted through international and local knowledge sharing and capacity building 

programmes.  

 

c. Interactive client services for supporting the national key issues 

It is expected that the mechanism proposed, via the education and research programmes would 

promote prospective clients‟ demands. Hence, the prospective stakeholders individually or as an 

organization shall take part in specific projects which shall be accompanied with a financial 

proposal.  

 

d. It is also proposed that the prospective projects shall utilize the expertise knowledge avails in both 

the stakeholder organizations.  However, it will be considered to hire the expertise from retired 

surveyor professionals considering their knowledge and experience in respective fields. 

  

e. In concern with the national and international Agro-GIS related issues, ISM shall commence 

stakeholders‟ collaborative researches, feasibility studies and fact finding reports etc. as private-

public-partnership basis in order to cater the clients‟ demands. 

 

7. Current Issue and Needs of Agro-GIS intervention 

 

Weligama Coconut Leaf Wilt Disease 

 

  The disease was found in 2006 in Weligama in Southern province. Since then biological 

investigations have been carried out and remedial actions were taken by the Coconut Research 

Institute (CRI) and related stakeholder communities. Most productive precaution identified is to cut 
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and destroy the deceased trees and isolation of affected plants. An inventory has been maintained to 

list out the addresses of the affected trees.  

 However, with the current status, the decease has been spread over the adjoining three districts; 

Matara, Hambantota & Galle.  

Therefore, the coconut growers association has requested the Surveyor General to carry out a GIS 

based study for analysing and monitoring the temporal parameters and ecological aspects of 

spreading the disease.  

The above context is totally related with Agro-GIS applications. Therefore, the Surveyor General 

has directed the request to the director-ISM for conducting of Agro-GIS based collaborative project 

to document the respective geospatial data and designing of interactive database solution. 

  At present the ISM in collaboration with CRI is discussing to draft a database solution in respect of 

the same burning issue. 

 

8. Discussion and Remarks 

 

Agro-GIS; as modern web based, GNSS integrated user friendly systems are becoming well popular 

among the world agriculture community. The cost of agricultural products is becoming too high with 

unbearable inflation. However, in Sri Lanka, the farmers income rates and social status are 

comparatively at a lower stage and most of the people in the agriculture industry are very 

unsatisfactory. Therefore, the responsible professionals and organizations should find methodology and 

mechanisms to upgrade the social economic status of the farmers and planters. 

 

Integration of modern technology in the field of agriculture can be learned as the most important issue 

in this era. Therefore, the efforts in the geo-spatial data forum which enables smart GIS and Remote 

Sensing applications, must be a reality with true project oriented and should be productive for economic 

growth of the respective stakeholders. 

 

There are many application software used around the world in respect of Agro-GIS. Meanwhile, 

general GIS application software too can be customised to suit the specific needs. However, it is 

necessary to study the specific requirements and defining the specific entities to achieve  expected 

sustainability. 

 

As the proposal is application oriented research and education programme, it is expected to plan for a 

few short courses initially and consider extended long term certificate courses in due course. 

 

As detailed under sustainability and motivation, it is necessary that the proposed Agro-GIS should cater 

the national issues related with livestock farming, plantation and small scale cultivation too. As the 

proposed project is collaborated with the Kahagolla agriculture research division, achieving their 

respective goals and application designing would be realistic. 

 

Annexures; 

1. Agro-GIS Enabling Technology 

 

 

 

 



භැනුම් ඿ඟයා඼        epy msitr; rQ;rpif   SURVEY JOURNAL                     

 

 
Page | 33  

 

Agro-GIS Enabling Technology 

 

Introduction 

 

Agro-GIS can explicitly be elaborated as Geographical Information System which relates the 

agriculture parameters through various aspects. As the GIS is very popular amongst the Geo-spatial 

data community with its advanced technology linked with many other interactive data sources play a 

dramatic role via internet protocol. As such the terminologies; Web-GIS, Mobile-GIS, Internet-GIS are 

becoming the hand pick tools for many applications. While the Global Navigation Satellite Systems 

(GNSS) and Satellite Remote Sensing prove the real time global positioning at high accuracy status, 

every aspects of GIS applications become a realistic for spatial data users. These technological 

provisions inspire the field of agriculture with integrated user friendly systems which are well popular 

among the world agriculture community. Therefore, this submission elaborates a few collection of 

enabling technological aspects, which privilege in the field of Agro-GIS. It is noteworthy to mention 

that the Agro-GIS enabling technology provisions used by world community are extremely vast and 

unable to collect in to one single document. Therefore this effort is just to inspire and motivate the local 

readers‟ mindset towards respective researches and innovations. 

 

GIS applications play an important role in the production of crops, both locally and across the globe. 

Through assisting farmers in increasing production, reducing costs, and providing an effective means of 

managing land resources, GIS has become an increasingly invaluable resource. Its applications come in 

a variety of forms, including precision farming, drone and satellite technologies and the capabilities of 

Geographical Information Systems themselves. 

 

More complex spatial analyses for agriculture might compare variables like soil type, wind direction, 

rainfall amount, slope, aspect, topography, or elevation to assist with crop management, site suitability, 

and drainage planning, as well as risk prevention from flood, drought, erosion, and disease.  

GIS can help a farmer adapt to these different variables, monitor the health of individual crops, estimate 

yields from a given field, and maximize crop production.  

 

Precision Farming 

 

Sensors on satellites, tractors and in fields are constantly collecting data. GIS and other technologies 

shape this data into information that is accessible and interpretable by farmers and land managers to 

make efficient and informed decisions. 

 

The use of precision GPS by farmers has become an essential tool in the agriculture industry. The 

technology has many cost saving and productivity advantages for farmers, as well as benefits for the 

community and the environment. A key example being its use in fertilizing crops, where machine 

sensors gather information about the crops, and the GPS records the exact position where it‟s applied in 

the field. The technology then aids the application of fertilizer only to the areas where it is needed, and 

can vary the rate of application to target nutrient-deficient sites. This saves money on fertilizer product, 

as well as the environment from over application and runoff into local streams and rivers. 

 

Variable rate technology (VRT) is the component of precision agriculture, which really enables the data 

to be put directly to use. It joins farm machinery, control systems, and application equipment to apply 

Annexure-1 
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precise amounts of growing inputs at exact times or locations. Precision farming with VRT has both 

economic and environmental advantages. Applying seed, fertilizer, nutrients, or pesticides only where 

and when they are needed can have a substantial cost savings for the farmer and boost revenues. 

 

Additionally, negative environmental impacts from over application of some chemicals are alleviated, 

and the use of certain chemicals could potentially be eliminated entirely based on data analysis. 

Persistent dilemmas like nitrogen application can also be addressed, helping the farmer find the right 

amount between excessive and insufficient. Once a system is in place, a precision agriculture operation 

follows a closed loop cycle that would look something like: collect/analyze data, plan the harvest, apply 

the plan, and analyze the results for the following season. 

 

Real-Time Mapping 

The use of satellites and drones has dramatically grown in the past few decades.  With one of the key 

farming challenges being the availability and management of water for agricultural purposes, satellite 

technology can collect real-time data from the Earth‟s surface to assess and monitor the condition of the 

land. Soil Moisture Ocean Salinity (SMOS), vegetation growth using satellite imagery, and applying 

the Normalized Difference Vegetation Index (NDVI), as well as a variety of other factors, can all be 

used to help estimate crop productivity and monitor drought and flooding on a global scale. 

 

Drone technology is useful in collecting more local field data such as; plant height and biomass, flora 

counts, disease and weed presence, nutrient values, elevation and volume calculation. Drones can 

replace time-consuming tasks, normally performed by scouring fields on foot, to assess qualities of the 

flora and vegetation present. Farmers are thus able to cover more ground, inspecting the health of the 

crops using aerial imagery and other data that the drone can record. 

 

For these purposes, and many more, satellites and drones can be used by farmers to make real-time 

actionable decisions. Monitoring yields, applying nitrogen, using precision water sensors and 

identifying critical areas for intervention are all valuable uses that this technology can provide. Just one 

basic drone can provide farmers with the ability to make many powerful decisions that will impact the 

health and productivity of their land. 

 

Forecasting for National Issues 

 

In the United States of America, the National Agricultural Statistics Services (NASS) have developed 

an online mapping application called CropScape. This application can provide area estimates of crops, 

estimate the type of crop growing and how large the size of its yield could be. Not just for privatised 

use, government agencies have used CropScape data to assess such national issues as; food security, 

pesticide control and changes to land-use. 

 

Meeting the Future Demand for Food 

 

For today‟s governing agencies, the need to secure the necessary food sources to support the continuous 

rise in population has been a growing concern. It has been estimated that the current production of 

crops will need to double by 2050 in order to meet future needs for food. For such purposes, GIS is not 

only being used for real-time analyses, but also to compare historical data. Satellite imagery can be 
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used to assess historical trends of agricultural land use over time. This can help to predict and plan for 

the amount of arable land needed to supply food to the future populations. 

 

Raising Awareness 

 

One of the most important functions of GIS and mapping is to be used to raise awareness of such issues 

as food scarcity, and “locating areas that are in need of assistance. Web mapping tools like the Institute 

of the Environment and the University of Minnesota’s Feeding the World map and the Food and 

Agriculture organisation of the United Nations (FAO)’s World Hunger Map provide a unique view of 

global food production.” Though establishing the underlying causes of food insecurity, GIS data and 

technology are helping to safeguard the areas and communities affected by food scarcity. 
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Metric Calibration Base at the Institute of Surveying and Mapping, 

Diyatalawa 
Mr. Mahendra de Alwis, Chartered Surveyor and Visiting Lecturer (Retired Superintendent of Surveys) 

____________________________________________________________________________________ 

 

It is indeed with great pleasure that I set out to put down some of the salient features that comprised the 

construction of the Metric Calibration Base at the Institute of Surveying and Mapping Diyatalawa. 

 

1971 dawned and batch No T4 moved in, the UNDP Project “UN/ISM” was to wind up by the end of 

the year and the ISM, exclusively with the Survey Department staff, was to continue from early 1972. 

The construction of the Metric Calibration Base for the purpose of Standardizing metric tapes was 

proposed in 1970. This was designed by Prof. Claud B. Noailles. All directions were also made 

available made by him. The construction was during the period January to August 1971. What is seen 

on the surface is nothing compared to the work done, during the construction below the surface of the 

Calibration Base. The Calibration Base was constructed by me. The site selected was near building No 

24A.  

 

Dr. Per Olof Fagerholm, Project Manager, UN/ISM has given mostly the outline. The site was approved 

by Project Co-Manager Mr. Elmore M. Perera. The necessary directions, advice and guidance were 

given by Prof. Noailles and I carried out the construction, along with my other work as an Instructor at 

the ISM, including everything related to my class of students in Batch T4. The six (6) drawings below 

give an indication of the magnitude of the construction. I shall try to make a little more elaborate 

account of the works done, if the need arises in a separate article, but would like to make mention 

herein of the fact that the group of Menum Sahayakas including those with special skills that worked 

with me on this work, performed with dedication and devotion! I can never forget the incident, where 

Survey Labourer Mr. K. A. Wipulasena, Menum Sahayake,  suffered a severe “slipped Disc” and had to 

be hospitalized. He was bed-ridden for more than a month! I visited the patient daily. Although he was 

in the gang of Oi/c Camp, I had to do everything necessary to get Mr. Wipulasena‟s accident leave 

authorized, together with matters pertaining to the Workers Compensation Ordinance. 

 

The steps taken before the actual construction were as follows:- 

 

1. Selection and marking two sites (One for Surface Taping and the other for Taping in Catenary) 

2. Setting out and levelling the site 

3. Digging with precision and also preparing Moulds 

4. Purchasing and transporting materials etc. 

5. Constructing reinforcement for the slab. 

6. Constructing monuments 

7. Constructing a drain across the calibration base 

8. Excavation for monuments 

9. Digging the trench with absolute precision for the slab 

10. Excavation for supporting blocks 

11. Sieving and washing sand 

12. Cleaning broken metal and finally “Positioning” monuments with absolute precision during the 

construction 
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The 100 meters T-shaped (inverted T) reinforced concrete slab, projecting ¼” was built “in SITU” in 14 

parts (sections) with gaps of ¼” as expansion joints and at each expansion joint a supporting block was 

placed immediately underneath the slab, with an asphalt filling at each ¼” expansion joint, to 

accommodate the expansion and contraction and asphalt paper placed immediately beneath the slab. 

 

The reinforcement was by way of three iron bars held in the form of a triangle and running along each 

section of the slab in concrete mix. The slab carries 10 meters unit brass plates, flush with the slab, the 

“O” Mark Pillars at the two ends. The 50 Meters Pillar and the Anchorage Pillars also at the two ends 

beyond the “O” Mark Pillars and 3 Tension Pillars in appropriate positions. They have been buried in 

concrete in their correct relative positions with absolute matriculation. Brass plates with “O” marks 

have been fixed a-top the “O” Mark Pillars. The 10 Meters unit brass plates too have been positioned 

with absolute precision. All these positioning and processes had to be carried out before the concrete 

hardened. All the pillars referred to above were constructed “pre-fab” in accordance with the precise 

dimensions indicated in the drawings, in respect of each of the pillars. At the same time, aspects such a 

Temperature (using Thermometers) Tension (using Spring Balances), Atmospheric Pressure (using 

Aneroid Barometers), Alignments (using T 16 Theodolite) and Horizontality (using the NA 2 

Automatic Level), all at one and the same time and before the concrete hardened, were in fact making 

the construction really challenging and nerve-rending. 

 

The prior preparation and “turning out” metal items and making appropriate purchases in the company 

of Prof. Noailles were indeed rewarding. Sieving and washing the sand (to desalinate), cleaning the 

broken metal and stones, digging appropriate pits for the concrete mixture carrying the pillars, digging 

Trenches to prevent roots of trees harming the slab, building a brick wall surrounding the slab and 

getting the retaining wall by the side of Diyatalawa - Bandarawela main road done up for greater 

stability, were some of the other items that were necessarily attended to by me. I have made a long story 

short. The whole process is better imagined than described. The Calibration Base thus constructed is 

generally for “Surface Tapping” but could be used for other purposes as well. 

 

Another Calibration Base for chaining in CATENARY was also planned, but it did not see the light of 

day. Towards the latter part of the year, my engagement took place. In early 1972 I assumed duties as 

an Instructor in Surveying, on “secondment” at the Polytechnical Institute, Badulla, but commuted from 

Diyatalawa for duties. In 1973 we shifted to Bandarawela and in January 1974, shifted back to 

Diyatalawa and remained there till 1978. During the period I was Oi/c Camp. 

 

Further, I would like to express the view that it would be perhaps useful, if the other Calibration Base 

for chaining in CATENARY shown in drawing No. 6 is also constructed, particularly for training 

purposes. This construction should be very much simpler, less costly and involving much less time and 

labour than the construction done already. 

 

Every detail in the construction done is not included herein. However the six (6) drawings would be 

quite useful in assessing the magnitude of the construction and the rigors gone through. It is most 

gratifying to have been able to put down on record, even in this abstract form, some of the salient 

features and events that marked the various stages of the construction of the above Metric Calibration 

Base in very pleasant surroundings at the Survey Camp, Diyatalawa. 
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Applications of Surveying in Land Management 

Mrs. J.K.A.D. Iranganie, Senior Superintendent of Surveys (Research & Development) 

____________________________________________________________________________ 

 

The origin of Surveying has a close connection with the designation of the land boundary, and cadastral 

surveying is the basis for a country‟s land management, serving as an important tool to gather, assess, 

and update geographical spatial data. In the contemporary era, Surveying is more widely used in 

different branches of land management. Moreover, the number of techniques and data acquisition 

methods has dramatically increased in the last 30 years.  On the one hand, traditional optical 

instruments have developed thanks to the integration to computers and electronic devices. On the other, 

new sensor techniques became available to be used from ground-based stations, mobile terrestrial 

vehicles, and low-altitude aerial platforms (e.g., helicopters and Unmanned Aerial Vehicles – UAV).  

The diffusion of Global Navigation Satellite Systems (GNSS) for precise positioning and navigation 

has not only completely changed the approach to land surveying, but also had an impressive impact on 

day-by-day life and the entire society. Mobile mapping technology allowed an increase in the 

productivity of high-resolution mapping of communication roads and urban environments, thanks to the 

integration of different sensing and positioning systems.  

Digital photogrammetry and laser scanning sensors can be used for fast acquisition of dense point 

clouds useful to model terrain, buildings, civil constructions and infrastructures, as well as any other 

natural or man-made objects.  While some main surveying instruments were used for the full data 

collection process in the past, data and sensor integration play a fundamental role today. In particular, 

the availability of digital data has changed the operational workflows for data acquisition, production, 

distribution, and management of surveying outputs.  

On the other hand, the concept of land management also developed its content, going in several other 

directions rather than traditional cadastral and topographic applications. Detailed 3D digital mapping is 

now more important because more aspects of buildings and the urban environment have to be 

considered, for example the ones related to energy efficiency. Also changes of buildings and land over 

time have attracted great interest in the mapping process, not only to have up-to-date three-dimensional 

spatial databases, but also to keep record of the evolution process in 4D digital maps. In some cases and 

when available, historical maps are integrated in the archives. Geographic data need to be accessible to 

a wider number of users through the Internet, where web services have been developed to allow people 

to interact with maps and geocoded data. In addition, the availability of several online map services 

allowed to create added value by supporting commercial applications and location based services 

(LBS).  

 

Crowdsourcing information can be continuously uploaded by the users in order to validate, integrate 

and update existing geographic data. The development of large facility management networks requires 

the precise survey for their geo-referencing and overlap to other digital map archives adopted for land 

management. In such applications, geographic information systems (GIS), real-time GNSS and ground 

penetrating radar systems are used in an integrated way to survey objects in the underground. Modern 

surveying techniques are also adopted for security issues in land management, including assessment of 

land safety, emergency management. This Special Issue entitled „Applications of Surveying in Land 

Management‟ presents different applications based on some of the technologies illustrated above.  
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Thanks to the recent development of digital photogrammetry it has fully demonstrated to be a powerful 

and cheap tool for 3D data acquisition and modeling of complex objects. The availability of low-cost 

digital techniques extended its use to a large community of people, although the knowledge of the basic 

theoretical principles is still necessary for a correct use. 
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Printing of Paysheets and Payslips (GPS) using printers other than Dot 

matrix printers 

Mr. E.M.D.M.Ekanayake, Senior Deputy Surveyor General (Mapping) 

____________________________________________________________________________________ 

 

The problem of printing above mentioned documents using non DOT matrix local or network printer 

can be overcome by adopting following method. 

 

1. Printing of Pay sheets 

 

 

a)  Install following freely available softwares 

 

a.  Jaspersoft iReport Designer (iReport) ( i.e.  iReport-5.6.0-windows-installer.exe).  

Latest version of this software can be downloaded from 

http://sourceforge.net/projects/ireport website. 

  

b. Java runtime environment (i.e. jdk-8u45-windows-i586.exe for 32 bit or jdk-8u45-

windows-x64.exe 64 bit operating systems respectively). Latest version of this software 

can be downloaded from http://www.java.com/en/download/index.jsp website. 

  

 

b) After running GPS programme for a particular site, relevant copy of the Paysheet is located in 

C:\\GPS\ directory as PSHEET.RPT 

  

c) Start iReport 5.6.0 software and open the file named PSHEET.RPT  located in the directory 

mentioned in 2.b above. Then select OK in the following message 

 

 

 

 

 

 

 

 

         

 

  

 

                                                              

Fig 01 

 

 

 

 

http://sourceforge.net/projects/ireport
http://www.java.com/en/download/index.jsp
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d) Then select File>Print to get the following screen 

 

 

 

                                                                    

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 02 

 

e) Then select File>Print Option to get the following screen  

 

 

 

 

 

 

 

 

 

 

     

 

 

 

 

  

 

 

 

           

          

 

 

                                                                        Fig 03 
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f) Where Tick off default selection of Print Border, Print Header, Print Footer and select option 

Fit Width to 1 page. Then press Apply and OK and select Page Setup in Fig.02 to get the 

following screen.  

 

                     

                                                                                 

                                                                                   

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 04 

 

g) Select paper size as A3 and orientation as Landscape. Set both Top and Bottom margins as 

1.4” and leave Left and Right margins as default selection (1”) and perss OK. Now select Print 

in Fig.02 to obtain relevant print out. 

 

2. Printing of Pay slips 

 

a) Install following freely available software 

a.   ( i. e jarte_53_setup.exe). Latest version of this software can be 

downloaded from http://www.jarte.com/ website. 

  

b) Then open the software so you will get the following screen which is the Compact Layout 

(Default Layout) of the interface.  

 

 

 

 

 

 

 

 

 

 

 

Fig 05 

http://www.jarte.com/
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c) Now click on the most left hand side icon of the four icons located at the middle of the interface 

under black back ground and select option of Minimal Layout. Then open the file named 

PYASLIP.RPT located in the directory mentioned in 2.b above and get the following screen.   

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                       Fig 06 

  

d) Go to File>Page Setup, click on General tab to get the following screen and select relevant 

printer. Then click on Printer Settings, select paper size as A3, orientation as Landscape and 

click OK.     

 

 

 

 

 

 

 

 

 

 

Fig 07 

e) Click on Page Margin tab and check settings. Leave default settings (1”) for all the margins. 

Similarly leave default settings for Header & Footer information also and click OK to go back 

to the Fig. 06. 

 

f) Now arrange page breaks using enter key to set only one set of data to remain in between two 

page breaks. If required, page breaks can be manually inserted by using Insert>Insert Page 

Breaks command in Fig. 06. Then go to File> Print to obtain print outs. 
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Geoid Modeling around the World 

Mrs. K.A. Pushpakanthi, Government Surveyor (Research & Development) 

____________________________________________________________________________ 

 

The geoid which is defined as an equipotential surface of the Earth gravity field (Heiskanen and Moritz, 

1967). High accuracy Geoid Modelling leftovers as one of the major issue in physical geodesy.  

The closed equi-geopotential surface nearest to the mean sea level which is defined as Geoid serves as 

height datum system and plays a significant role in different significant application fields such as 

compute Mean Sea level heights from ellipsoidal heights observed by GNSS. 

The geoid can be determined using various methods such as the gravimetric, geometric, astro-geodetic, 

astro-gravimetric, transformation and hybrid methods.  

 

The gravimetric method can be carried out by the well-known Stokes-integral using gravity data. In the 

geometric method, the geoid undulations of points are obtained from GNNS observations and geodetic 

levelling. The levelling of these points is carried out with respect to the Mean Sea Level. 

The Stokes‟ method and Molodensky‟s method are two classical Geoid modelling methods used to 

determine a geoid or quasi-geoid by solving the boundary value problems called the Stokes boundary 

value problem and the Molodensky boundary value problem. Stokes‟ method determines a geoid and 

Molodensky‟s method determines a quasi-geoid. Both these methods have its own advantages and 

disadvantages too.  

To overcome these disadvantages a new method was proposed and introduced based on definition of 

geoid, and used the external gravity field models (e.g. EGM2008), digital topographic models (e.g. 

DTM2006), Shuttle Radar Topography Missions and crust density models etc.  

Nowadays, satellite gravity missions, i.e. CHAMP, GRACE and GOCE, were launched, significantly 

improving the knowledge of the gravity field, but global models from satellite missions are limited in 

terms of spatial resolution due to the dampening of the gravity signal with the orbital height. The spatial 

resolution of Global models can be increased by using ground gravity data. But it is also related to the 

way in which those heights and gravity data were observed. 

 

Two type of applications are used in high resolution accurate global 

gravitational modeling. First, in land areas, GNNS positioning and 

gravimetrically determined geoid heights leads to determine the 

orthometric heights and undulations without levelling observations. 

Second, in sea areas, altimeter derived Sea Surface Heights are used 

to determined absolute Dynamic Ocean Topography and its slops. 

Combination of these two types of observations offer unique and 

accurate global high degree gravitational model and it is used to 

provide the reference surface for the realization of a global vertical 

datum, the Geoid model.  

Earth Gravitational Model EGM96 and EGM2008 are spherical 

harmonic models of the Earth's gravitational potential, developed by 

Figure 01: Geoid undulations 

of the model EMG2008 



භැනුම් ඿ඟයා඼        epy msitr; rQ;rpif   SURVEY JOURNAL                     

 

 
Page | 45  

 

a least squares combination of the ITG-GRACE03S gravitational model. Over areas covered with high 

quality gravity data, the discrepancies between EGM2008 geoid undulations and independent 

GPS/Leveling values are on the order of ±5 to ±10 cm. 

 

SGG-UGM-2 is the latest earth gravity model provided in 2020 from satellite gravimetry, satellite 

altimetry, and Earth Gravitational Model 2008 (EGM2008) derived gravity data based on the theory of 

the ellipsoidal harmonic analysis and coefficient transformation.  

Online conversions of the heights from ellipsoidal to orthometric heights or vice versa, of a single point 

or a set of points from a csv file by using one of these geoid models are also available.   

 

Hence the accuracy of such global geoid models are few decimeters and it is not sufficient for many 

scientific and engineering applications, high resolution regional geoid models are still necessary for the 

most practical purposes. Therefore most of the countries attempt to have their own Geoid Models and 

also regional geoid models as the availability of their own mean sea level heights and gravity data 

observed by various methods. Most of them are gravimetric or hybrid geoid Models such as Argentina 

(GEOIDEAR16), Australia (AUSGEOID2020), Canada (CGG2013/CGG2013a), Europe (EGG2015), 

Germany (GCG2016), Japan (GSIGEO2011), New Zealand (NZGEOID2017), USA 

(xGEOID19B/GEOID18), France (QGF98), Corsica (QGC02), Italy (ITALGEO05), Iberian Peninsula 

(IBERGEO2006), Belgium (BG03), Switzerland (CHGEO2004Q), Greece (GreekGeoid2010). 

 

 

 

In the South India area, a gravimetric quasi-geoid has been estimated in 

cooperation with the National Geophysical Research Institute of 

Hyderabad that supplied 16013 gravity data. Data over the surrounding 

seas were derived from High Resolution Altimetric Gravity Field 

Mapping (KMS2002 Global Marine Gravity Field). The final global 

gravity data base consists of 63968 values. The standard “remove-

compute-restore” procedure was adopted to estimate this quasi-geoid. 

The residual component was computed via Fast-collocation. The 

estimated quasi-geoid plotted is shown on figure 03.  

 

Figure 02: Countries having Regional Models by Map (Asia and Europe) 

Figure 03: The South India 

quasi-geoid 

https://www.isgeoid.polimi.it/Geoid/America/Argentina/argentina2016_g.html
https://www.isgeoid.polimi.it/Geoid/America/Argentina/argentina2016_g.html
https://www.isgeoid.polimi.it/Geoid/Oceania/australia20_g.html
https://www.isgeoid.polimi.it/Geoid/America/Canada/canada2013_g.html
https://www.isgeoid.polimi.it/Geoid/Europe/europe2015_g.html
https://www.isgeoid.polimi.it/Geoid/Europe/Germany/germany16_g.html
https://www.isgeoid.polimi.it/Geoid/Asia/Japan/japan11_g.html
https://www.isgeoid.polimi.it/Geoid/Oceania/Newzealand2017_g.html
https://www.isgeoid.polimi.it/Geoid/America/USA/USA2019_g.html
https://www.isgeoid.polimi.it/Geoid/America/USA/USA2019_g.html
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In Japan hybrid geoid model, GSIGEO2011 was established by fitting Gravity geoid model 

JGEOID2008 to geoid heights determined from GNSS/ Levelling at 796 GEONET stations, 29 tidal 

stations and 197 benchmarks. JGEOID2008 was a combination of global geopotential models 

GGM02C and EMG96, surface gravity measurements, altimetry derived marine gravity model 

KMS2002 and 250m mesh digital elevation model of Japan.    

For determining accurate local geoid model for Sri Lanka both gravimetric and geometric methods 

should be combined as a hybrid model. Enhancement of the coverage of the existing vertical control 

network with high accuracy and highly maintenance of the system is necessary for the quality of the 

model. The gravity observations in the areas where the geometric data is not existing is also a necessity 

for increasing the well distribution of the data for the geoid model.     
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